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Chapter 1: Introduction to RiskyProject 



What is RiskyProject? 

RiskyProject is advanced project risk management software with integrated risk analysis. Most 
projects contain many uncertain parameters: task duration, start and finish times, uncertainties in 
costs and resources, uncertainties in quality, safety, technology, and others. RiskyProject analyzes 
project schedules with risks and uncertainties, calculates the chance that projects will be 
completed within a given period of time and budget, ranks risks, and presents the results in 
formats that are easy to read and understand.  

RiskyProject also helps you to perform project risk management: 

 identify project risks  

 rank risks 

 identify mitigation and response plans 

 manage risk properties, including descriptions, probabilities and impacts, costs associated 
with risks, mitigation strategies, and all other information about risks 

 facilitate risk reviews, opening and closing risks, conversion of risks to issues and lessons 
learned 

 save risk history 

RiskyProject performs both qualitative and quantitative risk analysis. If both the risk register and 
project schedule are populated, RiskyProject performs quantitative risk analysis. If there is no 
project data (cost or schedule), RiskyProject performs qualitative risks analysis.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RiskyProject seamlessly integrates with Microsoft Project or can run as a standalone application. 
RiskyProject integrates with other project management software such as Oracle Primavera. 

 

Project Schedule Risk Register 

RiskyProject 

Microsoft Project, Oracle 
Primavera, and other Project 
Management software 

Monte Carlo 
Simulations 

Risk Adjusted Project 
Schedule 

Ranked Risk and Evaluated 
Mitigation/Response Plans 

Qualitative risk 
analysis 

Quantitative risk 
analysis 
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Qualitative vs. Quantitative Risk Analysis  
RiskyProject performs both qualitative and quantitative risk analysis.  

A typical qualitative risk analysis workflow is used to: 

1. Identify risks and add risks to the risk register. 

2. Define risk properties, probabilities, and outcomes. 

3. Analyze risks and prioritize risks. 

4. Assign mitigation and/or response plans. 

5. Update risk properties, probabilities, outcomes as necessary. 

6. Review status and properties of the risk and report information about risks. 

A typical quantitative risk analysis workflow is used to: 

1. Create a project schedule. 

2. Add risks, uncertainties, and other risk-related information.  

3. Run a simulation, perform an analysis and generate a report of the results.  

4. Update risks and uncertainties as necessary. 

5. During project execution, perform project tracking with risks and uncertainties at key phases 
or milestones to update forecasts. 

6. Report results 

If you do not have a schedule for your project, RiskyProject will only perform qualitative risk 
analysis. However, if you add a schedule by either adding activities or importing a schedule, 
RiskyProject automatically switches to quantitative analysis. You may switch between qualitative 
and quantitative analysis by adding or removing a project schedule. 

 

 

 

 

Due to the nature of qualitative and quantitative analysis the results can be different even with the 
same risks, particularly for schedule-related risks affecting project duration and cost. 

 

Qualitative risk 
analysis 

Quantitative risk 
analysis 

Adding or removing 
project schedule 
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Chapter 2: Qualitative Risk Analysis 
and Management 

 

 



Risks in RiskyProject 

Risk Register 
The Risk Register is a set of all the project risks. You can enter risks in either the Risk Register 
or Risk Properties views: 

 

 

 

 

 

Use the Risk Register to: 

1. View risks with their attributes such as probabilities, impacts, scores, and properties. 

2. Create a risk register hierarchy based on: 

 Risk categories 
 Open/Closed risks 
 Risk/Issues/Lessons Learned 
 Risks assigned to managers 
 Risks assigned to owners 
 Threat mitigation or opportunity mitigation strategies 
 Assigned/Unassigned Risks (active or inactive) 

View risks hierarchy based on 
the different parameters, 
categories, owner, manager, 
open/closed, etc. 

Click Risk Register 
or Risk Properties 
to view risk register 

Click Risk Register 
or Risk Properties 
to view risk register 

Risks are ranked 
based on their 
scores 

Select open or/and closed risks Select risks, issues or lesson learned 

Filter risks based 
on their properties 

Sort risks 
alphabetically or on 
risk ID 

Risk hierarchy 
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 Hidden and Visible risks (available in RiskyProject Enterprise only, see RiskyProject 
Enterprise User Guide) 

3. Rank risks based on risk score. 

4. Sort risks alphabetically or using risk IDs. 

5. Filter risks based on risk properties: Open, Closed, Risk, Issue, or Lessons Learned. 

Data for the Risk Register can be subdivided into three categories: risk registry, risk 
mitigation/response plans, and settings: 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Risk Register 

Risk 1 with attributes: 

General 
Information  

Risk cost Probabilities 
and impacts 

Mitigation / 
response plan 
assignments 

Risk history Risk reviews Custom 
properties 

Risk 2 with attributes 

Risk 3 with attributes 

………………… 

Mitigation or response plans  

Plan 1 with attributes 

Plan 2 with attributes 

…….. 

Risk Register Settings  

Risk Categories 
and Outcomes 

Default Risk 
Properties 

Risk Matrix 
settings 

Risk ID 
generation rules 



 

Adding risks to the Risk Register 

1. Click the Risks tab. On the Risk Views group, click the Risk Register.  

2. On the Risk Register, click an empty row. 

3. Enter a unique name for the risk. The risk is now added to the register.  

Deleting risks from the Risk Register 

1. Click the Risks tab. On the Schedule Views group, click the Risk Register. 

2. Select the risk you want to delete. You can select a single risk or multiple risks. 

3. Right-click on the Risk ID and choose Delete Risk from the shortcut menu.  

Updating risk properties for individual risks 

To modify the risk properties using the Risk Register: 

1. Open the Risk Register. 

2. Click on the risk properties and make desired changes. 

Updating risk properties for a group of risks 

You can define the same risk properties for a group of risks at the same time. 

1. Open the Risk Register. 

2. Select the risks to which you would like to add properties. 

3. Right-click on the risk ID and select Risk Properties. 

4. For each property, add a value as required. If properties are different for the selected risks, 
you will be shown with *******. 

 

With the Risk Register or Risk Properties views, you can rename risks and copy risk information to the 
clipboard. You may also copy and paste risks inside the Risk Register. 

 

About Risk Categories, Probabilities and Impacts 

Risk Categories 

Risk Categories are a group of risk outcomes. RiskyProject calculates risk probabilities, impacts 
and scores for each category. The default risk categories are: 

 Duration 
 Cost 
 Safety 
 Environment 
 Legal 
 Performance 
 Technology 

RiskyProject calculates the score and rank for all risks in each risk category. You can view risk 
scores and rankings for each risk category or for all categories. 
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You can customize the risk categories in the Risk Categories dialog box. For more information 
about customizing risk categories, read “Managing Risk Categories and Outcomes”. 

Risk Outcome Types 

A Risk Outcome Type is the result if a risk occurs. While every risk category must have a least 
one outcome, they can have several. For example, one of the default risk categories is Legal. You 
may want to further define the outcome types as Litigation Risk, International Legal Risk, etc.  

You can customize the set of outcome types using the Risk Categories dialog box.  

 

The set of risk outcome types are different for qualitative and quantitative risk analysis. For 
quantitative risk analysis, RiskyProject automatically adds a number of schedule-specific risk 
outcomes, such as restart task, fixed cost increase, etc. 

 

Risk Probability and Chance 

Risk Probability is the calculated chance that an event will occur. You can view risk probability 
in the Risk Matrix, Risk Register, and other views and dialog boxes. Risk Chance is the input 
parameter for risk probability. Risk chance (input parameter) and risk probability (calculated 
attribute) can be different; particularly when a risk has multiple mutually exclusive alternatives as 
risk chance is an input parameter for each alternative. In these cases, Risk probability is 
calculated based on the risk chance for each mutually exclusive alternative. 

Risk Outcome 

Risk Outcomes indicate the severity of a risk event for the specific risk category. You need to 
enter risk outcomes when you define risk chance and outcome type. For example, here are the 
default risk outcomes for the risk category Schedule: 

 

Outcome types can be a label (e.g. Critical > 1 year delay) or a percentage (e.g. 5%), or a 
combination of both. You can set how you want to enter and view risk outcomes in the Format 

Default list of risk outcomes can be customized in 
Format Risk Matrix dialog. 

In the Risk Register, Risk Properties, Risk Matrix, and Risk 
Report you can view risks associated with a specific risk category 



Risk Matrix dialog box. Each label is associated with percentage, which is the midpoint of the 
interval for each label: 

Label Interval Midpoint 

Negligible: < 1 month delay From 0% to 20% 10% 

Minor: 1-3 month delay From 20% to 40% 30% 

Moderate: 3-6 months delay From 40% to 60% 50% 

Serious: 6-12 months delay From 60% to 80% 70% 

Critical: > 1 year delay From 80% to 100% 90% 

When you define outcome types as a percentage, you can enter it as any number from 0% to 
100%. In this scenario, it will be associated with a label based on the interval to which this 
percentage belongs. For example, 76%, corresponds with the “Serious: 6-12 months delay” 
outcome type. 

The diagram below shows the relationship between risk categories, risk outcome types, and risk 
outcomes. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

Threats and Opportunities 

Risks can be threats, opportunities or both. Threats and opportunities are defined for risk 
assignment depending on results of the risk outcome. Negative risk outcomes mean opportunities. 

Risk Impact 

Risk impact is the calculated result of the risk event. Risk outcome (input parameter) and risk 
impact (calculated attribute) can be different, particularly when a risk has multiple mutually 
exclusive alternatives, in which case the risk outcome is a parameter of each alternative. Risk 
impact is calculated based on the risk chance for each alternative. 

The diagram below shows the difference between risk chances and outcomes (input parameters) 
and risk probabilities and impacts (output parameters):  

Risk Category 

Duration 

Cost 

Legal 

….. 
Risk Outcome Type 

Litigation Risk 

International Legal 
Risk 

….. 

Risk Outcome 

Very low 

Low 

Medium 

High 

Expressed as labels Expressed as a 
Percent

 

75 % 
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Risk Score 

Risk score is a calculated parameter that equals probability multiplied by impact. Risk score is 
calculated for each risk category as well as all risk categories. 

Original, Pre-, and Post-Mitigation Probabilities, Impacts and Scores 

RiskyProject calculates three sets of probabilities, impacts and scores for each risk category as 
well as for all categories: 

1. Original: when risk chance and outcome are defined. This information is saved in Risk 
History. If you want to change original probabilities, impacts and scores you would need to 
make modifications in Risk History using the History tab on the Risk Information dialog. 

2. Pre-mitigation or Current: reflects most recent changes to chance and outcomes. If you 
simply enter chance and outcome, your original probability, impact and score will be 
represented as Pre-mitigation or Current value. 

3. Post-Mitigation: Pre-mitigation probability, impact and score, with changes to do mitigation 
plans. 

You can view all sets of probabilities, impacts, and scores in the Risk Register. 

Risk Properties 

Risk Properties are other risk attributes, which include: 

 Risk Name, ID, description, statement, objectives, assumption, cause and trigger 
 Open/close risk  
 Risk life cycle status: Risks, issues, lesson learned 
 Risk ownership 
 Risk mitigation strategy 
 Risk costs 
 Risk start and end date  
 Other information about risk 

Some risk properties are predefined as General Information about risk and Risk Costs. However, 
you may define any other risk properties.  

Risk 1 has multiple outcomes: for different categories and different mutually exclusive alternatives 

Safety – 70%  

Schedule – 50%  

Cost – 50% 

Outcome 

Safety – 30%  

Schedule – 30%  

Cost – 30% 

Chance 

Impact - 70% Probability – 30% 

Integrated probability and impact for 
all parameters Calcu

lation 



Risk Mitigation and Response Plans 
You can model risk mitigation or response efforts in RiskyProject using the Mitigation or 
Response View. Response plans are activities that are executed when a risk occurs and are used 
for quantitative risk analysis. Mitigation plans are actions that are performed to minimize risk 
probability and/or impact and can be visualized using the Risk Mitigation Waterfall diagram. 

A mitigation or/and response plan must be assigned to a particular risk. Please read “Assigning 
Risk Response Plans” and “Assigning Mitigation Plans” for more information. 

Creating a mitigation or risk response plan 
1. Click the Risks tab. In the Risk Views group, click Mitigation/ Response Plans.  

2. Enter the mitigation or response plan name. Summary entries will help you to organize 
information, but they are not considered a mitigation plan. 

3. Select either Mitigation or Response plan 

4. For Response plans, enter an Outcome Type and Outcome of the response. The outcome 
types are automatically populated based on the list of outcome types.  

5. Enter the Cost of the mitigation or response plan 

6. For Mitigation plans, enter the default reduction of probability and impact if the mitigation 
plan is assigned to the risk.  
For example, a mitigation plan reduces probability on 5% and impact on 10%. If a mitigation 
plan is assigned to the risk that has 45% probability and 30% impact before mitigation, the 
risk will have 40% probability and 20% impact after mitigation. 

7. Enter the mitigation or response plan description. If you double-click on a 
mitigation/response plan ID, the Mitigation or Response Plan Description dialog box will 
open. 

 

A mitigation or response plan can be assigned to multiple risks. The cost of mitigation or response 
plans will be included with each risk. 

 

Creating Summary and Sub-plans 

Mitigation plans can be composed of Summary plans with associated sub-plans. This can be very 
useful if your mitigation plans have several activities or steps that have distinct costs and 
outcomes that you want to monitor items separately. 

Summary plans have names only and do not have Plan Type, Outcome Type etc. Summary and 
sub-plans are defined using the Indent and Outdent commands similar to Summary and Subtasks 
on the Gantt Chart. 

To create a sub-plan: 

1. Enter a name for the Summary plan. 

2. Click the row below the plan  

3. Enter a name for the plan. 
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4. Right-click on the plan and on the shortcut menu click Indent. The plan now becomes a sub-
plan of the mitigation plan.  

5. Enter information for the sub-plan. 



Risk Attributes 

About Risks 
Each risk in RiskyProject can have a number of attributes. Some of the most common attributes 
are predefined and are found in the Properties tab of the Risk Information dialog box; however, 
you are not required to complete all of them. The information required should be defined as part 
of your risk management plan. 

General Information includes: 

 Risk Name: the risk name for each risk must be unique. Names are case-sensitive.  
 Open/closed risk: open risks are active risks that may occur. Closed risks are those risks 

that are no longer active because of risk response or other factors or measures taken. 
Closed risks may contain important information and should not be deleted from the risk 
register.. 

 Risks, issues, lessons learned: risks are events that may or may not occur and have a 
probability between 0 – 100%. Issues are events that have already occurred and require a 
response. Lessons learned are events that occurred in the past and have a history 
associated with them. When you add a new record to the risk register, by default it is a 
risk.  

 Risk statement, objectives, assumption, cause and trigger: contain textual information 
about risks. 

 Risk ownership: includes risk manager and risk owner. You may define other custom 
fields for risk reviewer, recorder, and other participants in the risk management process. 

 Risk mitigation strategy: you can enter mitigation strategies for threats and/or 
opportunities. Status of threats and/or opportunities are automatically calculated when 
you enter risk probabilities and impacts. If the risk is only a threat, you will only be able 
to enter strategies for threats and vice versa. For more information about threats and 
opportunities, read “Risk Probabilities and Impacts”. 

 Risk start and end date (risk sunrise and sunset): dates between which a particular 
risk is active.  

 Risk ID: Risk ID can be automatically generated when you create a new risk. You may 
sort the Risk Register based on Risk IDs. You can overwrite the automatically generated 
risk ID. Rules for risk ID generation are defined in Risk Options. To view Risk Options, 
click the Schedule tab. In the Settings group, click Options. 
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Risk Probabilities and Impacts 
There are two ways probabilities and impacts can be defined in RiskyProject: 

 You can define chance and outcome for each risk in the Probabilities and Outcomes tab 
of the Risk Information dialog box.  

 You can also define risk chance and outcome directly in the Risk Register grid. However, 
in this case, risk cannot be assigned to any tasks or resources. If risk is already assigned 
to at least one task or resource, you will not be able to modify chance and outcome using 
the grid and the Risk Information dialog box will appear. This method is preferable for 
qualitative risk analysis and risk management. 

Defining risk chances and outcomes in the Risk Information dialog box 

You must enter the risk chance, outcome type, and outcome for each risk. You may only define 
one alternative. Please remember that risk chance and outcome may not be equal to calculated 
risk probabilities and impacts in the following cases: 

 For risks with multiple mutually exclusive alternatives  
 If you define uncertainties in risk outcome 
 In case of quantitative risk analysis (with project schedule) 

General Information 
about Risks 

Risk Cost calculation 

Information about risk 
review 

Risk Response 
planning 



To define risk chances and outcomes in the Risk Information dialog: 

1. Click the Risk tab. In the Risk Views group, click Risk Register.  

2. Double- click on a risk ID to open the Risk information dialog box. 

3. Click the Probabilities and Outcome tab. 

4. Enter Chance which will be used to calculate probability. 

5. Select Outcome Type from dropdown list. 

6. Select Outcome label from dropdown list or enter percent. 

7. Threat/Opportunity will be calculated automatically if you enter a negative outcome. 

8. If required, repeat steps 5 -7 for each mutually exclusive alternative. 

 

Use the Format Risk Matrix dialog box to toggle between entering risk outcomes as labels, 
percentages, or both. 

 

Defining risk chances and outcomes in the Risk Register grid 

By default, the Risk Register’s columns don’t allow you to enter risk chance and outcome 
directly. You need to define appropriate columns first: 

1. Within Risk Register or Risk Properties views, right click on the header of the column next 
to which you want to define that column in order to enter chances and outcomes. 

2. Click on Insert Column Before or Insert Column After. 

3. Select field from the Field Type dropdown list. Here is the list of columns which can be 
presented in the Risk Register: 

Field Description Calculated (Read 
Only) 

Impact Original Calculated impact of risk when it is first entered in the Risk 
Register 

Calculated 

Impact Pre-mitigation Current calculated risk impact Calculated 

Impact Pre-mitigation Current calculated risk impact with minus changes due to 
mitigation efforts factored in 

Calculated 

Impact: Cost Risk Outcome: Cost Category, current or pre-mitigation  

Impact: Cost, Post-
mitigation 

Risk Outcome: Cost Category, post-mitigation  

Impact: Environment Risk Environment: Cost Category, current or pre-mitigation  

Impact: Environment, 
Post-mitigation 

Risk Environment: Cost Category, post-mitigation Calculated 

Columns for Chance (Probability) and Score are defined the same way. After you define 
appropriate columns, they can then be used to enter the risk chance and outcome for each 
category.  
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About Cost of Risk Calculations 
Risk cost calculates the total cost of a risk that takes into account the risk mitigation plans linked 
to the risk. The Risk cost calculation is performed in the Properties tab of the Risk Information 
dialog box. 

Risk cost calculation  

1. Enter Potential Loss: the loss in monetary terms if the risk occurs.  

For example, for the risk “low quality component”, the potential loss is $50,000. It is the 
cost that you would incur if a low quality component was supplied. 

2. Probability Before Mitigation comes from the Probabilities and Outcome tab of Risk 
Information dialog box. See Risk Probabilities and Impacts for more information. 

3. Expected Loss takes into account that the risk may not occur It is an indicator that helps you 
to compare the costs of different risks. 

Expected loss = Potential Loss * Probability (pre-mitigation) 

For example, probability of risk “low quality component” equals 50%. Potential loss 
equals $50,000. Expected loss will be $25,000 = $50,000 * 50%  

4. Cost of Mitigation is taken from Waterfall tab of Risk Information dialog box. It is the 
cost associated with efforts to reduce the probability and impact of the risk.  

For example, mitigation plans will include “Additional QA procedure” and “QA audit of 
supplier’s operation”, which would cost $10,000 in total. 

5. Even if a mitigation plan is executed as planned, there will still be a cost associated with a 
risk as it is possible to reduce risk, but not to eliminate it (an exception is when you are able 
to avoid the risk). The response plan may be executed if the risk occurs and will be calculated 
using the cost entered for the response plan associated with this risk. This cost is entered 
Mitigation and Response view.  

For example, if the risk “low quality component” occurs, this component needs to be 
replaced with a new one, which would cost $20,000. 

6. Residual risk may still occur after the risk response and is cost is calculated as the Cost of 
Residual Risk.  

For example, the new component installed as a risk response can still be defective. The 
residual cost of the risk will be $10,000.  

7. Probability after Mitigation comes from Waterfall tab of Risk Information dialog box. 
See “Risk Mitigation and Response Plans” for more information. 

For example: Risk Probability after mitigation equals 25% as a result of the execution of 
the mitigation plan “additional QA procedure”, probability of risk “Low quality 
component” is reduced two times. 

8. Expected loss after mitigation takes in to account the fact that risk may not occur.  

Expected loss after mitigation = (Cost of Response Plan + Cost of Residual Risk) * 
Probability after information 

For example, probability of risk “low quality component” after mitigation equals 25%. 
Expected loss after mitigation will be $7,500 = ($20,000 + $10,000) * 25%  

9. Total Risk Cost after Mitigation = Expected loss after mitigation + Cost of Mitigation 



For example: Total cost after mitigation of risk “low quality component” will be $17,500 
= $7,500 + $10,000 

10. Saving from Mitigation is the difference between costs with and without mitigation. If this 
number is negative mitigation efforts will not lead to cost saving. 

Saving from Mitigation = Expected Loss – Total Risk Cost after Mitigation 

For example, total cost after mitigation of risk “low quality component” will be $17,500. 
Expected loss $25,000. Saving from Mitigation is $7.500. Because this number is 
positive, it makes sense to perform mitigation efforts. 

Assigning Mitigation Plans 
You can assign mitigation plans defined in the Mitigation and Response view to your risks. One 
risk may have multiple sequential mitigation plans. They can be shown as a Waterfall diagram. 

Waterfall diagrams can be used to visualize the timing of mitigation efforts over the course of the 
project.  

 

 

 

 Pre-mitigation probability and impact are the results of calculation. Therefore, they cannot 
be updated in the waterfall tab.  

Select a mitigation plan or subplan from the 
drop-down list. You can also enter a mitigation 
plan here and it will be automatically added to 
the Mitigation and Response view. 

Enter the date, 
when mitigation 
efforts will occur. 

Colors for the waterfall 
diagrams are defined by the 
risk tolerance (see Format 
Risk Matrix). 

Enter probability and impact on each 
mitigation phase. The score will be 
calculated automatically. 

Mitigation cost 

Probability and 
Impact of risk 
before and after 
mitigation are 
shown here. 

Planned mitigation 

Actual mitigation 
from History tab
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 Probability, impact, and score for the last mitigation effort are converted into the post-
mitigation probability, impact, and score and will be shown in the Risk Register. 

 You can view Planned and Actual risk mitigation efforts. Actual mitigation efforts are taken 
from the History tab on the Risk Information dialog. 

 

Viewing waterfall diagrams: 

1. Open the Risk Register view. 

2. Double click on Risk ID. The Risk Information Dialog box opens.  

3. Click the Mitigation (Waterfall diagrams) tab. 

4. Enable or disable Actual and Planned mitigation lines using check boxes on the left bottom 
corner. 

 



Risk Matrix and Risk Trend Chart 
Risk Matrix and Risk Trend views allow you to determine the severity of a risk and analyze how 
risks are changing over time: 

 The Risk Matrix is a tool that allows you to determine the severity of a risk. The Risk 
Matrix view shows this using the risk probability (y-axis) vs. calculated risk impact (x-
axis) of the project risks. The Risk Matrix view is divided into two sections: a table with 
a list of risks with their actual calculated values for probability, impact, and score. When 
you select these risks, they are shown visually on a matrix, which provides a visual 
comparison of this data put as well as putting each risk into the context of your 
organization’s risk tolerance.  

 The Risk Trend shows how project risk change over time. The Risk Trend can be 
presented as bar chart, stack area chart, or in table format (Total Risks). 

 The Risk History shows how the probability and impact of an individual risk has 
changed over time. 

 The Risk Monitor shows the number of risks per cell in the risk matrix. 
 

 

 

 

 

Select risk to display it 
on the Risk Matrix 

Select risk category to 
view the risks 

Threats and opportunities are 
viewed separately 

This risk is selected 

Risk trend shows how risks are 
changing over time. Total Risks 
shows risk trend in the table format.

Number of risks 
for each cell 

How probabilities and impacts 
of risks are changing over time 
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Risk Report 
Risk Report is a view, which presents attributes of selected risks. The report for one risk may 
contain one or many pages. The total number of pages per report equals the number of selected 
risks multiplied by the number of pages per risk. The Risk Report includes six sections: 

1. General Properties 

2. Pre- and post- mitigation probabilities, impact and score 

3. Cost of Risk  

4. Custom Properties 

5. Waterfall Chart 

6. Mitigation Plans 

Each page of the risk report contains a header and footer. The header and footer may include up 
to three lines of text and a logo located on the left or right side. 

You can customize the Risk Report in the following ways: 

 Select the order and turn on and off any section of the report 
 Customize any particular section by enabling or disabling any attribute and customizing 

labels of the attribute. For example, by default the label for risk detailed description is 
called “Description”. Instead you may use “Information about risk”. 

 Customize headers and footers. Specifically, you can select a logo (company) that can be 
placed in the header and/or footer. 

 Modify attribute values or labels. 
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Chapter 3: Managing Project Schedules 



RiskyProject for Microsoft Project as a 
Standalone Application 

RiskyProject as a Standalone Application 
You can launch RiskyProject directly from the Windows Program menu. When you open 
RiskyProject, the main Project view appears in which you can enter schedule and risk, perform 
the analysis, track project performance and report the results.  

RiskyProject for Microsoft Project 
RiskyProject seamlessly integrates with all versions of Microsoft Project from 2003 and later. 
When you install RiskyProject, it checks if Microsoft Project is installed on the computer. If 
Microsoft Project 2003/2007 is installed, RiskyProject and adds a toolbar and macro to Microsoft 
Project. If Microsoft Project 2010/2016 is installed RiskyProject installs ribbon tab and Add-In to 
Microsoft Project. 

Here is how the integration works: 

1. The first time you open Microsoft Project after installing RiskyProject for Project, check to 
see that the RiskyProject toolbar (for Microsoft Project 2003/2007) or ribbon tab (for 
Microsoft Project 2010/2016) is visible. In Microsoft Project 2003/2007, you can enable or 
disable the toolbar by clicking on Toolbars in the View menu. In Microsoft Project 
2010/2016, you can enable/disable ribbon tab by clicking on Options in the File menu. 
Project Options dialog will come up where you can select Customize Ribbon. You can also 
check the installed RiskyProject add-in by selecting Add-Ins. 

2. Create a schedule in Microsoft Project. 

3. If you use ribbon for Microsoft Project 2010/2016: 

 Define statistical distributions for cost and duration of for selected tasks inside Microsoft 
Project; all statistical distributions are saved in RiskyProject file. 

 Add risk-related information in the RiskyProject views if necessary: risk events, 
probabilistic and conditional branching, probabilistic calendars, etc. 

 Perform Monte Carlo simulations 
 View results of analysis and reports in Microsoft Project 

If you use toolbar for Microsoft Project 2003/2007 statistical distributions need to be defined 
in RiskyProject views 

4. At any moment, you can go back to Microsoft Project and make changes to your schedule. 
All changes will be reflected in RiskyProject. However, if you make changes to the 
deterministic project schedule in RiskyProject, these changes may be overwritten by the 
Microsoft Project schedule. 
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Using Microsoft Project 2010/2016 Add-In 
Using the RiskyProject Add-In you can quickly add Low and High estimates for Cost and 
Schedule directly to your Microsoft Project file, run the simulation, and view the results of the 
analysis. 

 

 

 

 

Setting up the Add-In options 

You can set up your Monte Carlo calculation, chart, and field mapping options using the Add-In. 

Click the Go Back to Microsoft Project button in 
RiskyProject to view original schedule and resources 

Use the RiskyProject toolbar or ribbon tab 
in Microsoft Project: 

1. Define statistical distributions for 
selected task or group of tasks 

2. Run Monte Carlo Simulations 

3. View results of selected task or group 
of tasks 

4. Open the selected risk view or report 
RiskyProject.  

Microsoft Project 

Define 
distributions 

Run 
Monte 
Carlo 

View results 
for selected 
tasks 

View results 
and 
generate  
reports 

Settings 

 

RiskyProject Add-In 



 Calculation options include the maximum number of iterations and convergence 
monitoring and more. To read more about calculation options, read Error! Reference 
source not found.. 

 Field mappings allow you to modify the default fields where the distributions for duration 
and cost are saved. To read more about the mapping, read Error! Reference source not 
found. 

 

Adding Low and High Duration or Cost in Microsoft Project 

1. Select one or more activities. 

2. Click the RiskyProject 7 tab. On the Input Distributions group, click Duration or Cost. 
The Statistical Distribution dialog box opens. 

3. Enter in the Low and High estimates using coefficients or fixed values (single activity). 

4. Select a distribution and modify any parameters required by the distribution. 

5. Click OK. 

 

 

To clean edits made to distributions: 

1. Select the task or tasks in which you want to remove the distributions. 

2. Click the RiskyProject 7 tab.  

3. On the Input Distributions group, click Clean.	

Click to open dialog 
box to add 
distributions for 
duration or cost 

Run Monte Carlo 

View results and 
generate reports 
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Run a Monte Carlo simulation using the Microsoft Project Add-In 

Once you have added low and high estimates and distributions to your activities, you can run a 
simulation. 

To run a Monte Carlo simulation: 

1. Click the RiskyProject 7 tab.  

2. On the Input Distributions group, click Calculate. A progress bar will open and indicating 
the number of iterations that have been completed. 	

3. When the simulations are completed the Project Information report opens, which contains a 
project summary of the results of the simulation. 

 

View the results of the simulation for a task 

You can quickly view either histograms or tornado charts for a task. Only one task can be 
selected. 

To view a histogram or tornado chart for a single task: 

1. Click the RiskyProject 7 tab. On the Task Results group, click Histograms or Tornado. 
The Task Simulation Results report opens. To read more about these reports, see Error! 
Reference source not found.. 

2. Double- click on any of the reports to open a detailed view of the results. 



Create a statistics report 

You can automatically generate a report that includes a histogram, cumulative probability, and 
sensitivity analysis for one or multiple activities using the Statistics Report. To read more about 
the Statistics Report, see Statistics Report for Quantitative Analysis. 

To create report: 

1. Run a simulation. 

2. On the Task Results group, click Statistics Reports. The Statistics Report view opens. 

3. Select the activities that you want to include in the report. 

4. From the File menu, click Print to open the Print Options dialog box.  
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Creating Projects 

Creating a new project 
The original view for a new document is defined in the Options, View tab. The default view can 
be the last view in the previous RiskyProject session. 

1. Click File  and then New. The new project file opens. 

2. To save the project click the Save button and type in a project name. 

 

In addition to project files created in RiskyProject, you can also open files that have been saved as a 
Microsoft Project XML or MPX format. Microsoft Project XML  is the industry standard for project 
management software and is supported by Microsoft Project, Oracle Primavera, and many other 
project management software applications.  

 

Importing existing project schedules 
You can import existing project schedules from Microsoft Project, Primavera and other project 
management tools using a variety of file formats.  

Importing Microsoft Project files 

You can import MS Project files using MPX, or XML formats.  

1. Click File  and then Open. The Open File dialog box opens. 

2. Select the format that the project file is in from the Files of type drop-down list. 

3. Select the MS Project file format that you just saved. 

4. Click OK.  

 

You can use the RiskyProject toolbar or ribbon in Microsoft Project to transfer your schedule from 
Microsoft Project to RiskyProject. When you use the RiskyProject toolbar or ribbon, your schedule in 
Microsoft Project will be associated with risks and uncertainties defined in RiskyProject.  

 

Importing data from other project management software 

RiskyProject can import data from other project management software in MPX or Microsoft 
Project XML file formats. 

1. Click File and then Open  

2. Select the XML or MPX project schedule. 

 

Due to the specific features of each application and the probabilistic nature of RiskyProject data, in 
very rare cases there may be discrepancies between the original project schedule and the imported 



schedule in RiskyProject.
 

Importing data from other project management software and retaining risk 
assignments 

Sometimes you may want to import a project schedule from Microsoft Project or other software 
and retain existing risk assignments. It can be useful when you have imported a project schedule 
from Microsoft Project or other software, assigned risks in RiskyProject, and then updated the 
project schedule in Microsoft Project.  

1. Click File  and then Import. 

2. Select the format type of your project data (XML or MPX). 

3. Select whether or not you want to import the risks already assigned to the project.  

 

RiskyProject will associate assigned risks with new tasks based on unique task IDs. Unique IDs do not 
change when you insert or delete tasks. You can rename the task in Microsoft Project, but risks will be 
assigned to the proper task and resource based on this unique ID.

 

Importing risks and uncertainties from different RiskyProject file 

You can import risks and uncertainties from a different RiskyProject file and assign them to tasks 
and resources in the current schedule.  

1. Click File  and then Risks from Another Project. 

2. Select the RiskyProject file (alm extension) with risks and uncertainties. 

 

If the schedule originated in Microsoft Project, the risks will be assigned to the correct task and 
resource using the unique ID. Unique IDs do not change when you insert or delete tasks. If you 
created the schedule in the RiskyProject the risk will be assigned based to the tasks or resources 
based on ID shown in the task or resource data sheets. Such ID changes when you insert or delete 
tasks. 
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Project Tasks 
When you first start RiskyProject, the Project view opens. Start the scheduling process by adding 
tasks. Each task should have a name and a base duration. You can enter this information directly 
onto the datasheet or using the Task Information dialog box. 

Opening the Task Information dialog box 

The Task information dialog box can be used to enter task parameters (duration, start, finish 
times, assign resources to tasks, assign risks, etc.). You can open the task information dialog 
using one of the following ways: 

 Double click on Task ID 
 Right-click on task ID and Select Task Information 
 Select Task and Click on Project > Task Information 

Entering task name and duration 

When you create a task, the first step is to enter a name and a base duration. 

1. Click on the Task Name field in the Project view.  

2. Provide a name for the task. 

3. Enter a base duration in the Base Duration field. You can enter elapsed duration. Elapsed 
task duration is calculated using a 24-month calendar. To define elapsed duration, enter ‘e’ 
before units, for example, “10 edays”. 



 

Defining summary tasks and subtasks  

Summary tasks represent groups of tasks (subtasks) that can be logically grouped together under a 
larger task. In large projects with many tasks, this is a useful method of organizing your tasks. 

1. Create a task directly above the tasks that you want to group under it. This will become the 
Summary Task. 

2. Select the tasks that you want to be the subtasks of the summary task you created in step 1. 

3. Click the Indent button located on the Format toolbar to indent the tasks. The indented tasks 
are automatically recognized as subtasks of the summary task. If you want to move at task out 
from under the summary task, select the task and click the Outdent buttons. After you click 
on an Indent or Outdent button, RiskyProject automatically recalculates the project. 

 

Outline Selected Level 

You may view summary tasks associated with a particular level of the hierarchy using the Outline 
button (Schedule tab). 

Task Links 

All projects require that the WBS tasks be performed in a certain order. These relationships are 
defined in RiskyProject using the four linking buttons located on the standard toolbar. 

  

The four types of task dependencies are show in the following figure: 

 

 

If you want a next task to be a predecessor of a previous task, for example task 5 to be a 
predecessor of task 3, you will have to use Predecessors tab in Task Information dialog box. You can 
also use the Predecessors tab if you want to define lags time greater than zero. 

 

Use this buttons to 
change the level of 
the tasks 

Select tasks that you 
want to be subtasks 

Expand or collapse 
summary tasks 
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Remember the following rules: 

1. You cannot link summary 
task to one of its subtasks 

 

2. The predecessors of a 
summary task must have a 
finish-start or start-start 
dependency.  

 

3. You cannot create circular 
relationships. 

 

The connecting line between successors and predecessors will be red if there is a scheduling 
conflict:  

 

Predecessors and Lags 
You define information about predecessors and lags in the Predecessor tab of Task Information 
dialog box. 

You can use the Standard toolbar button to link tasks; however, this method of creating task 
dependencies has limitations: 

 You cannot link a task (from example Task #5) to a previous task (for example Task #3). 
 You cannot input lag, which is time delay between predecessor and successor. 

RiskyProject allows you to setup probabilistic lag with statistical distribution defined by 
low, base, high number. 

 

Sometimes it is convenient to use predecessor tab instead of link toolbar buttons when task has 
multiple predecessor or if there is a big difference in task Ids between current task and predecessor. 
For example, it is not convenient to link task number 5 to task number 74 using toolbar buttons. 

You can use Predecessor column within Project view to define or modify predecessors. Text: “1, 2+2 
days” would mean than current task has two predecessors (Task 1 and Task 2 with lag 2 days). 

 

Adding a predecessor to a task 

1. Select the task to which you want to add a predecessor. 

2. Open the Task Information dialog box.  

3. Click the Predecessor tab. 



4. On the first row of the grid, click in the Task Name cell. A drop-down list appears containing 
a list of all available tasks or type  

5. Select the predecessor from the drop-down list. By default, the predecessor type is Finish- 
Start (FS). 

6. If required, enter a lag time. Use the Lag low and Lag high cells to enter a range of time. Lag 
can be positive or negative 

7. Click OK. 

 

 You cannot make a task be a predecessor to itself 

 You cannot create a schedule that it will lead to a circular relationship between tasks 

 You cannot link a summary task to one of its subtasks 

 You cannot link two tasks twice. 

 

Constraints  
Constraints are limitations that you set on tasks. For example, you can specify that a task must 
start on a particular date or finish no later than a particular date. In RiskyProject, you can assign 
one of seven constraints to a task: 

 As soon as possible (default) 
 Start no earlier than 
 Must start on 
 Must finish on  
 Start no later than 
 Finish no earlier than 
 Finish no later than 

Use the General tab of Task Information dialog box to add or modify constraints. If you set a 
constraint to Start no Earlier Then, an additional edit box opens in which you set the date for this 
constraint. 

If you assign a constraint other than As Soon As Possible, the background color for low, base, 
and high Start Times or low, base and high Finish Times changes to orange to indicate that the 
constraint is other than As Soon As Possible.  

 

 

 

Use constraints to ensure that the task starts or finishes on the specific dates. Use caution when 
you link tasks with a constrained start or finish time with predecessors because of the potential for 
scheduling conflicts. In this situation, to avoid scheduling conflicts, set the constraint to As Soon 
As Possible.  

A red dot indicates that the constraint is 
not set to As Soon As Possible, Must 
start on and Must finish on

Shading constrained time (rather than 
As Soon As Possible) 
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Milestones 
You can flag a task as a milestone. If you turn on a milestone, the task bar within a Gantt chart is 
displayed as: 

 

Any task with zero duration is automatically displayed as a milestone in the Gantt chart; however, 
any task can be marked as a milestone. The milestone flag is for display only and does not affect 
the project calculations. 

If a task has no duration entered, it is automatically displayed as a milestone and you do not have 
to complete the following steps. If you want to flag a task that has duration, complete the 
following steps. 



Managing Resources and Work 
Resources are the people and equipment that are assigned or the material that is used to complete 
a task. 

Adding resources 

1. Click the Schedule tab. In the Schedule Views group, click Resources. 

2. Click on a row. 

3. Provide a Name (mandatory), Initials (optional), and Rate (mandatory). 

 You can group resources to define reams using the indent and outdent buttons. 
 Initials and notes are for information only and do not affect the calculations. 
 Rates affect the cost the task to which the resource is assigned. Rates for work resources 

can be per year, month, week, day, hour and minute. Rates for material resources are per 
unit (e.g. 10 tons).  

4. Select the resource type: Material, Cost or Work.  

 Material label indicates type of material resources (e.g. tons)  
5. Maximum units are used to calculate Overallocation of work resources. It is not used for the 

material or cost resources. 

 

 Use the Resource Information dialog box to assign resources risks. 

 You can add risks to a resource using the Risk tab of Resource Information dialog box. If you 
have only a few risks assigned to a few resources, this is the preferred method to define 
resource risks. If you have many resources, we recommend that you add the risks in the Risk 
Register of Risk workflow tab and then assign them to the resources from one of the risk 
views.  

 Default rate for resource type Work is defined in Tools > Options Cost tab. 

 
Assigning resources to tasks 

1. On the Schedule tab, in the Schedule Views group, click Project View. 

2. Select the task to which you want to assign the resource. 

3. Click in the Resource field associated with the task. 

4. Select a resource from the drop-down list. If you type in a new resource name, it will be 
added to the list of resources in the resource view. When you add a new resource in this 
manner, it will be assigned at 100% effort for work resource. 

5. Enter Cost for cost resources 

 
 Multiple resources can be assigned to a particular task. 

 Tasks do not have to have resources assigned to them.  
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Managing Costs 

Cost Calculations in RiskyProject 
You can define cost associated for tasks with risks and uncertainties.  

The example below illustrates how fixed and variable (resource) costs are calculated with respect 
to tasks and subtasks: 

 

 

 

The project schedule includes the summary task “Web Site Design”, the summary task “Art 
Works”, and subtasks “Selection of art work” (2 days duration) and “Purchase of art work” (0.2 
days duration). “Selection of art work…” has base fixed cost $200 and is assigned to the Graphic 
Artist with rate $50.00/hour. “Purchase of art work” has a base fixed cost of $400 and is 
performed by Purchaser with a rate of $40.00/hour. The work is supervised by project manager 
with rate $80.00/hour, but is only 10% his time is assigned to this project. It is assumed that a day 
has eight (8) working hours. 

 

The Fixed cost for the summary task is calculated as the sum cost of all subtasks, which do not 
have subtasks under them. Resource costs for summary tasks are calculated as cost of all 
resources assigned to summary task plus resource cost of all subtasks. 
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Chapter 4: Quantitative Risk Analysis 



Assigning Risks to Tasks and Resources 

Risk Assignments 
Risks must be assigned to calculate their impact.  If a risk is not assigned to any tasks or resources 
it will remain in the risk register, but probability, impact, and score will not be shown. 

RiskyProject has two types of risks assignments:  

 Global Risk Assignments – Global risk assignments are those risk assignments which 
have a chance of affecting the project as a whole and are not limited to specific tasks or 
resources. For example, political or weather risks would be assigned as global. 

 Local Assignments – Local risk assignments are those risks that have a chance of 
affecting only specific tasks or resources. A local risk assignment can affect more than 
one task or resource. For example, risks affecting the delivery of specific equipment for a 
certain phase of a project would be assigned local. 

 
You can edit or view risk assignments in the following dialog boxes and views: 

View  Dialog/Tab Local or Global  Assigned to 
tasks or 
resources 

Global Risk Assignment 
View  

 Global Risks. Local risks 
can be assigned from 
global risks  

Both task and 
resources  

Risk Register Risk information 
dialog (double click 
on Risk ID), 
Assignment tab 

Both local and global risk  Both task and 
resources 

Any view with task 
information (Project 
View, Result Gantt, etc.) 

Task information 
dialog (double click 
on Task ID), Risk tab 

Local risks Task 

Resource View Resource 
information dialog 
(double click on 
Resource ID), Risk 
tab 

Local risks Resources 
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Risk Attributes for Quantitative Risk Analysis  
Each risk has the following information related to quantitative analysis. 

 Risks can be assigned to Tasks or Resources 
 Risks are defined by the chance of occurrence (from 0% to 100%). The chance can be 

defined per task (by default) or per duration unit. For example, if there is a 30% chance 
that task can be restarted per day. If task duration is 2 days, the chance of the risk 
occurring per task is 60%. This chance calculation option is defined for all tasks and 
resources for the project in the Risk tab of the Options dialog box: 
 

 
 

 Each risk has a different outcome type. Outcome types can be schedule and cost related 
and non-schedule related, which you can customize using the Risk Outcome dialog box. 
Standard schedule-related risk outcomes are shown in the table. 
 

Outcome Type Description  

No Impact This is for information only and has no impact 
on project schedule 

 

Relative Delay 

Fixed Delay 

Durations will be expanded in the period, 
defined in the Result field regardless of, 
when the risk occurs. If the Result is 
negative, the task duration will be reduced. If 
task duration is elapsed, the delay will also be 
represented in elapsed units (edays, ehour, 
etc.) 

 

Relative Cost 
Increase 

Fixed Cost Increase 

Task related fixed costs are increased by the 
amount, defined in the field Result regardless 
of when the risk occurs. If the Result is 
negative, costs are reduced. These risks don’t 
affect cost per use. 

 

Restart Task Tasks are restarted from the moment the risk 
occurs. As a result, the task duration is 
increased.  

 

End Task Tasks are successfully completed when the 
risk occurs. As a result, the task duration is 
reduced.  

 

Cancel Task Tasks are canceled when the risk occurs. As 
a result, the task duration is reduced and the 
task is marked as canceled. 

 

Cancel Task + all 
successors 

Tasks and all its successors are canceled 
when the risk occurs. As a result, the task 
duration is reduced and the task and all its 
successors are marked as canceled. 

 



Rate Increase This risk can only be used on resources. If 
this risk occurs, the rate will be increase or 
reduce. For example, if the rate is $20/hour 
and risk outcome is 50%, the rate will be 
$30/hour if the risk occurs. This outcome 
affects project cost. 

 

Execute Response 
Plan 

Result field for this risk contains a dropdown 
list with mitigation plans. They come from 
Risk Mitigation or Response view. If task has 
multiple local and global risks, which require 
execution of the particular mitigation or 
response plan, this plan will be executed only 
once. 

 

 The Outcome is related to the outcomes “Fixed cost increase”, “Relative cost 
increase”, “Fixed delay”, “Relative delay”, and “Rate Increase”. It defines how much 
the duration or cost will be increased or reduced.  

 RiskyProject calculates the Risk Impact for duration and cost using sensitivity analysis 
and displays this in the Risk Register, Global Risk Assignment views and Risk Tabs for 
Tasks and Resources. Colors are used to indicate the level of correlation between the risk 
and project duration and cost.  

 Red indicates a strong correlation 
 Yellow a medium correlation 
 Green a weak or no correlation 
Colors for threats are the opposite. Particular colors for the risk impact value depend on the 
risk tolerance defined in Format Risk Matrix dialog box. 

 Most likely: 80% 
 End:  100%   

This description means that by default for A new task with duration 10 days risk would occur 
after 5th day, but most likely would occur on 8th day.  

Assigning local and global risks 
Once you have added your risks you can start assigning your local risks to tasks and resources. 
You cannot assign the same local risk to both a task and a resource. RiskyProject offers a number 
of ways to assign risks to task and resources. 

Method 1: Assigning global and local risks using Risk Register 

This method is useful when you edit risk assignment, for example for mitigation planning. You 
will be able to view all risk assignments in one place.  With the risk register, you can assign both 
local and global risks. 

1. Open the Risk Register. 

2. Double- click on the risk to which you want to add properties. 

3. Click the Assign to tasks or resources tab. 

4. Depending upon whether you are assigning local or global risk to a task or resource click on 
the first empty row in either the Tasks or Resources tables.  

5. Select the task or resource from the drop-down list. You may select “All Tasks” or “All 
Resources” for global risk assignments. If you select a specific task or resource, it will have a 
local risk assignment. 
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6. Click the row ID cell the item you just select to enable the Selected assignment table to the 
right. This is where you define the risk assignment. 

7. Click in the Chance cell to start entering the Chance, Outcome, and Result of the risk. 

8. Click in an additional row to enter a mutually exclusive risk alternative. A risk alternative is a 
different outcome from the same event.  

This shows how you assign risks to tasks in the Risk Register. Click the How to Assign Risk 
button to view this directly in the application. 

 

 

 Use the Pie Chart for mutually exclusive risk alternatives to as a guide for how they affect 
the overall chance that the risk will occur. 

 If you do not enter chance, outcome, results assignment will not be saved even you selected 
task or resources.  

 

Method 2: Assigning Local Risks Using the Task Information dialog box 
and Resource Information Dialog Box 
You can define task risks in the Risk Tab of Task Information dialog box. All risks entered here 
are “local risks” and will not appear in the Global Risk Assignment view. It is a preferred 
method if you want to assign few different risks to few separate tasks and resources. 

1. Open the Task Information or the Resources Information dialog box. 

2. Click the Risks tab. 

3. Double click on Risk Name field and type in the name of the risk.  

4. Use the Indent/Outdent buttons to create a hierarchical structure of risks. This simplifies the 
enabling and disabling of risks. If you enable a summary risk, all of its risks are enabled and 
vice-versa. 

5. In addition to the above steps, you can: 

 Click the Enlarge button to expand the view and make it easier to assign risks. 



 Click the Load Risks from Global Risk Assignment View or Load Risks from 
Template button to load all risks from the Global Risk Assignment View or from a risk 
template.  In this way, you can create a master list of risks in either the Global Risk View 
or a risk template, load it here and enable or disable risks as required. 

 Clear the Apply global risks to this task check box (it is selected by default) if you do 
not want to include this task in global risk calculations. 

 

 You cannot add risks to summary tasks. 

 Ensure that you have clearly defined your risks and uncertainties. For example, if you have 
already accounted for risk using a range (Base, High, and Low) of durations; do not add this as 
a risk as it is accounted for twice in the calculations. 

 
 

 
 

Use indent/outdent 
buttons to create 
summary risks 

Uncheck this box if you 
don’t want to apply global 
risks to this task 



47 

 

Managing Uncertainties 
If you have accurate historical statistical data that is analogous to a particular element in your 
project, we recommend that you use this data to model uncertainty in your project as opposed to 
risk events. Be aware of double-counting risk and uncertainty as most of the uncertainty in a 
project is due to the probability of risk events occurring. 

To define uncertainties: 

1. Define a 3-point estimate for any of task parameters: cost, duration, and start time. 3-point 
estimates for work will be calculated automatically based on uncertainty in duration. You 
may also define 3-point estimates for the lag.  

2. After you define 3-point estimates, a statistical distribution will be assigned.  

Adding 3-point estimates for task duration and start times 

1. On the Project view, double-click on the task ID.  

2. Click the General tab.  

3. Select a Base, Low, and High dates for Start Time.  

4. Select a Base, Low, and High values for Duration. By default, when you enter a value for 
duration, the default values for Low and High are calculated based on the defaults set in the 
Duration Options. 

5. Click OK to save the estimates. 

Adding 3-point estimates for task cost 

1. On the Cost view, select the task to which you want to add cost estimates 

2. Enter cost data for Cost Low, Cost, and Cost High. By default when you enter a value for 
Cost, the default values for Low and High are calculated based on the Cost defaults set in the 
Cost Options.  

3. Click OK to save the estimates. 

Adding 3-point estimates for lags 

1. On the Project view, double-click on the task ID. 

2. Click the Predecessor tab.  

3. Enter Low, Base, and High Lag. Default triangular statistical distribution will be generated 
automatically.  

4. Click OK to save the estimates. 



Analyzing Results 

Results Gantt Chart 
RiskyProject displays the start and finish ranges of each task in the Result Gantt view. The 
calculated project and baseline schedules are shown in the same Gantt chart. You can use the task 
bar for current schedule to compare deterministic and probabilistic schedules. 

 

 

You can display Result Gantt associated only with low (optimistic) and high (pessimistic) results.  

Showing or Hiding Low/High Results 

1. Right-click on the chart and a shortcut menu opens. 

2. From the shortcut menu, choose one of the following viewing options: 

 Show Low/High Results 
 Show Low Results 
 Show High Results 
 Show Current Schedule. 
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Resource Allocation 
The Resource chart shows the time allocation for a selected resource. 

 

 

For the resource chart to open, two conditions must be met: 

 You must select the Chart check box for a resource in the resource sheet. 
 The selected resource must be assigned to a task. 

Overallocation 

Select a checkbox to 
indicate the data that 
you want to view in the 
chart. You can view 
baseline or probabilistic 
results

Select a checkbox to 
indicate which resource 
time allocation will be 
shown on the chart. 
Only one resource can 
be selected at a time. 

Right-click on the chart 
to open a shortcut 
menu. You can select 
Zoom In, Zoom Out, 
and Zoom All 



Statistics Report for Quantitative Analysis 
Once you have completed the Monte Carlo simulation, you can quickly generate a statistics report 
for selected tasks in your project schedule. The statistics report can include histograms for Start 
Time, Finish Time, Duration, and Cost as well as a Sensitivity to Finish Time table with a 
Tornado chart. Statistics reports can be exported to PowerPoint. 

To create a statistics report: 

1. Run a simulation on your project. 

2. Click the Reports tab. In the Report Views group, click Statistics Report. 

3. Select the activities that you want to report on by clicking the check boxes beside the activity 
names.  

 

 

To export a statistics report to PowerPoint 

1. Click the Report tab. Click Statistics to PowerPoint. Alternatively you may click on Click 

File  and then click Export -> Microsoft PowerPoint. 

2. If Microsoft PowerPoint is installed on your computer, PowerPoint will be launched and the 
report will be generated using settings defined in Customize Report dialog. Only frequency 
and cumulative probability charts and tornado (sensitivity) plots are exported to PowerPoint.  

 

Click the checkbox to select the 
activity 

Customize the report 

Preview of the report 

Export report to 
PowerPoint 


